Training Document for Comprehensive Automation Solutions

Totally Integrated Automation (T I A)

MODULE D16
PROFIBUS DP
with
Master CPU 314C-2DP/Slave ET 200S
This document has been written by Siemens AG for training purposes for the project entitled "Siemens Automation Cooperates with Education (SCE)". Siemens AG accepts no responsibility for the correctness of the contents.

Transmission, use or reproduction of this document is only permitted within public training and educational facilities. Exceptions require the prior written approval by Siemens AG (Michael Knust michael.knust@siemens.com).

Offenders will be liable for damages. All rights, including the right to translate the document, are reserved, particularly if a patent is granted or utility model is registered.

We would like to thank the following: Michael Dziallas Engineering, the teachers at vocational schools, and all others who helped to prepare this document.
The following symbols provide a guide through Module D16:

- **Information**
- **Programming**
- **Sample Exercise**
- **Notes**
1. PREFACE

In terms of its contents, Module D16 is part of the teaching unit entitled 'Industrial Fieldbus Systems'.

Learning Objective:

In Module D16, the reader learns how PROFIBUS DP with the CPU 314C-2DP as master and the ET200S as slave is started up. Module D16 illustrates the method in principle, using a brief example.

Prerequisites:

To successfully work through Module D16, the following knowledge is assumed:

- Knowledge in handling Windows
- Fundamentals of PLC programming with STEP 7 (for example, Module A3 - 'Startup' PLC Programming with STEP 7)
- Fundamentals of PROFIBUS DP (for example, Appendix IV - Basics of Fieldbus Systems with SIMATIC S7-300)
Hardware and software required

1. PC, operating system Windows 2000 Professional starting with SP4/XP Professional starting with SP1/Server 2003 with 600MHz and 512RAM, free hard disk storage 650 to 900 MB, MS Internet Explorer 6.0

2. Software STEP7 V 5.4

3. MPI interface for the PC (for example, adapter USB)

4. PLC SIMATIC S7-300 with CPU 314C-2DP
   Sample configuration:
   - Power supply: PS 307 2A
   - CPU: CPU 314C-2DP

6. Distributed periphery ET 200S for PROFIBUS with 2 digital inputs and 4 digital outputs
   Sample Configuration:
   - Interface Module IM151-1HF
   - Power module PM-E DC 24V ...48V/AC 24V...230V
   - Electronic module: 2DI Standard DC 24V
   - Electronic module: 4DO Standard DC 24V/0.5A

6. PROFIBUS cable with 2 PROFIBUS connectors
2. NOTES ON USING THE CPU 314C-2DP

The CPU 314C-2DP is a CPU that is shipped with an integrated PROFIBUS DP interface and integrated inputs and outputs.

The following PROFIBUS protocol profiles are available for the CPU 314C-2DP:

- DP interface as master according to EN 50170
- DP interface as slave according to EN 50170

PROFIBUS-DP (distributed periphery) is the protocol profile for connecting distributed periphery/field devices with very fast response timing.

Another special characteristic is that in the case of this CPU, the addresses for the input and output modules can be programmed.

Its performance is particularly suitable for training purposes, considering the following data:

- 48Kbyte work memory, load memory MicroMemoryCard (MMC) insertable 64Kbyte to 4 Mbytes
- 8192 bytes DI/DO, of that 992 bytes central
- 512 bytes AI/AO, of that 248 bytes central
- 0.1 ms/1K commands
- 256 counters
- 256 Timers
- 256 Flag bytes
- 24DI, of that 16 can be utilized for integrated functions; all can be used as alarm inputs
- 16 DO integrated; of that 4 fast outputs
- 4AI current/voltage, 1AI resist. integrated
- 2 AO current/voltage integrated
- 4 pulse outputs (2.5kHz)
- 4-channel counting and measuring with incremental encoders 24V (60kHz)
- Integrated positioning function

Note: Here, CPU 314C-2DP is used as master on the PROFIBUS.
3. NOTES ON USING THE ET 200S WITH IM 151-1 HF

The SIMATIC ET 200S is a decentral IO device configured in a highly modular mode. It can be operated with different interface modules:

**IM 151-1 BASIC, IM 151-1 STANDARD** and **IM 151-1 FO STANDARD** for connecting a maximum of 63 IO modules (all types except PROFIsafe) to the PROFIBUS DP; alternatively, bus connection with RS 485 Sub-D connector or by means of integrated fiber-optic connection

**IM 151-1 HIGH FEATURE** for connecting a maximum of 63 IO modules (all types, including clocked mode for PROFIsafe) to PROFIBUS-DP; bus connection with RS485 Sub-D connector

**IM 151-3 PN** for connecting a maximum of 63 IO modules (all types, including the clocked mode for PROFIsafe) to PROFINET IO controllers; bus connection by means of RJ45 connector

**IM 151-7/F-CPU, IM 151-7/CPU** or **IM 151-7/CPU FO** for connecting a maximum of 63 IO modules (all types; PROFIsafe only with IM151-7/F CPU) to PROFIBUS DP; alternatively bus connection with RS 485 Sub-D connector or by means of an integrated fiber-optic connection; with integrated CPU 314 of the SIMATIC S7-300, for preprocessing process data.

The following IO modules can be used:

- **Power modules** for individual grouping of load and encoder supply voltages and their monitoring
- **Digital electronic modules** for connecting digital sensors and actuators
- **Analog electronic modules** for connecting analog sensors and actuators
- **Sensor module** for connecting IQ sense sensors
- **Technology modules** Electronic modules with integrated technological functions, such as counting, positioning, data exchange, etc.
- **Frequency converters and motor starter modules**

For training purposes, an integrated system is available, suitable for teaching many technologies.

Notes:
- In Module D16, the interface module IM151-1 HF (HIGH FEATURE) is used as PROFIBUS DP slave.
- The PROFIBUS address is set, binary-coded, on 8 switches at interface module IM151-HF. The lowest switch has to be on OFF. A number is assigned to each of the other switches. These numbers add up to the PROFIBUS station address. If the PROFIBUS address is changed, the new setting will be accepted only after voltage returns. Therefore, the interface module IM151-1 HF has to be switched off, and then switched on again.
4. STARTING UP PROFIBUS (MASTER CPU314C-2DP/SLAVE ET200S)

Below, the startup of a single master system with the CPU314C-2DP as master and the ET200S as slave is described.

To test the configuration, a program is written. In this program, an indicator lamp P1 is activated when two buttons, S0 and S1, are operated simultaneously.

**Assignment List:**

<table>
<thead>
<tr>
<th>I0.0</th>
<th>S0</th>
<th>Button Selection 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>I0.1</td>
<td>S1</td>
<td>Button Selection 2</td>
</tr>
<tr>
<td>O0.0</td>
<td>P1</td>
<td>Indicator lamp</td>
</tr>
</tbody>
</table>

1. The central tool in STEP 7 is the 'SIMATIC Manager'. It is called here with a double click. ([→ SIMATIC Manager](#))

2. STEP7 programs are managed in projects. We are now setting up such a project ([→ File → New](#))

---

**SIMATIC Manager**

- Datei → Neues Projekt...
- Öffnen...
- Version 1. Projekt öffnen...
- SIMATIC Manager Card
- WML Daten
- Löschen...
- Reorganisieren...
- Verschieben...
- Archivieren...
- Druckervorrichtung
- Druckvorrichtung
- Druck/Wechsel
- Druckvorrichtung
- Druckvorsicht
- Druckvorsicht
- Druckvorsicht

---

**StartUp**
3. Now, the 'Name' 'ET200S' is assigned to the project (→ ET200S → OK)

4. Highlight your project, and insert a 'PROFIBUS Subnet' (→ ET200S → Insert → Subnet → PROFIBUS).
5. Next, a 'SIMATIC 300 Station' is inserted. (→ Insert → Station → SIMATIC 300 Station)

6. Now, with a double click, open the configuration tool for the 'Hardware'. (→ Hardware)
7. Open the hardware catalog by clicking on the symbol (→).

There, arranged in the following directories:
- PROFIBUS DP
- PROFIBUS PA
- PROFINET IO
- SIMATIC 300
- SIMATIC 400
- SIMATIC HMI Station
- SIMATIC PC Based Control 300/400

Insert 'Rail' with a double click. (→ SIMATIC 300 → RACK-300 → Rail)

After that, a configuration table for configuring Rack 0 is displayed automatically.
8. From the hardware catalog, you can now select all modules that are also in your real rack, and insert them in the configuration table. To this end, click on the name of the respective module, hold the mouse key and drag the module to a line in the configuration table.

We are starting with the power unit 'PS 307 2A'. (SIMATIC 300 → PS-300 → PS 307 2A)

**Note:** If your hardware differs from the one displayed here, simply select the corresponding modules from the catalog and insert them in your rack. The order numbers of the individual modules -that are also indicated on the components- are displayed in the footer of the catalog.
9. Next, we drag the CPU 314C-2DP to the 2nd slot. The order number and the version of the CPU can be read off the front of the CPU. (→ SIMATIC 300 → CPU-300 → CPU 314C-2DP → 6ES7 314-6CF00-0AB0)

10. When entering the CPU, the following window appears. In this window, assign a PROFIBUS address to the CPU 314C-2DP and select the PROFIBUS network that has already been created. If you want to modify the parameters of the PROFIBUS network, highlight it and then click on ‘Properties’. (→ Properties)
11. Now you can select the 'Highest PROFIBUS Address' (here → 126), the 'Transmission Rate' (here → 1.5 Mbit/s) and the 'Profile' (here → DP). (→ OK → OK)

12. Then, to the right of the CPU314C-2DP, a bar appears - the so called 'Master system' - where you can arrange PROFIBUS slaves. This is done by clicking on the desired module (here the 'ET 200S' with 'IM151-1 HF') in the hardware catalog in the path 'PROFIBUS-DP', and dragging it to the master system. (→ PROFIBUS DP → ET 200S → IM151-1 HF → 6ES7 151-1BA00-0AB0)
13. When entering the slave, the following window appears. In this window, assign a PROFIBUS address to the slave. The address has to be identical with the address that you set at the switches of the IM151-1 HF (→ 5 → OK).

14. From the hardware catalog, you can now select all additional modules that are inserted in your real ET200S and add them to your configuration table. To this end, click on the name of the respective module, hold the mouse key, and drag the module to a line in the configuration table. We are starting with the power module 'PM-E DC24V...48V/AC24...230V' that is dragged to Slot 1. (→ PROFIBUS-DP → ET 200S → IM151-1 HF → PM → PM-E DC24V...48V/AC24...230V)
15. Next, we are dragging the digital input module ‘2DI DC24V ST’ to the 2nd slot. The order number and the version can be read off the module. (→PROFIBUS-DP → ET 200S → IM151-1 HF → DI → 2DI DC24V ST)

16. Then, we drag the digital output module ‘4 DO DC 24V/0.5A ST’ to the 3rd slot. The order number and the version can be read off the module. (→PROFIBUS-DP → ET 200S → IM151-1 HF → DO → 4 DO DC 24V/0.5A ST)
17. The addresses of the input and outputs in the ET 200S can now be changed. This is done by double clicking on the corresponding input or output modules in the ET 200S and setting them under the tab 'Addresses'. These addresses should be noted down in each case. Addresses are assigned automatically in the sequence in which the modules are entered. (→ 2DI DC24V ST → Addresses → OK)
18. By respectively clicking on \( \text{Save} \) and \( \text{Compile} \), the configuration table is first saved, then compiled and then loaded to the PLC. The key switch on the CPU should be on Stop! (→\( \text{Save} \) →\( \text{Compile} \)).

19. The CPU 314C-2DP is then confirmed as the destination module of the loading process. (→\( \text{OK} \))
20. In the dialog window below, you can 'Display' the devices that are connected in the network. The station address of the CPU in the MPI network is then selected. If you are connected to only one CPU, accept with 'OK'. (→ Display → OK)

21. After the hardware configuration is loaded, you can start to generate the program. From the 'SIMATIC Manager', open 'OB1' with a double click. (→ OB1)
22. Optional: enter the properties of OB1 for documentation, and accept with 'OK'.

(→OK)
23. With ‘LAD, STL, FBD – Program S7 blocks’, you now have an editor with which you can generate your STEP7 program accordingly. To this end, OB1 has already been opened with the first network. To generate your initial operations, highlight the first network. Now you can write your first STEP7 program. In STEP7, individual programs are usually arranged in networks. A new network is opened by clicking on the network symbol. The STEP7 program to be tested can now be loaded to the PLC.

In our case, this is only OB1. Save the organization block and click on . The CPU’s key switch should be in the STOP position! (→ →)

24. Setting the key switch to RUN starts the program, and after clicking on the symbol for monitoring, the program can be monitored in ‘OB1’.

(→ )